Spreadsheet Basics

Spreadsheets are useful for the organized storage of information. This lab will discuss when spreadsheets are used and the basics of how to use them. We will be using LibreOffice CALC for our spreadsheet editor, but the concepts we cover can be transferred to any spreadsheet software. At the end of this lab you should not only be able to use a spreadsheet, but also be able to recognize problems that a spreadsheet can be useful for solving.

Goal:

Understand how to use the following spreadsheet concepts and features:

1. How they are organized - cells, rows, columns
2. How to plan and create a spreadsheet
3. What type of data can be stored
4. How to enter and edit data
5. How to write a formula
6. How to create a chart to visualize data
7. How to sort data

Background Information:

Spreadsheets are most commonly used to store and perform calculations on numerical data. Examples of data like this include a personal budget, business transaction records, data from scientific experiments (like daily rainfall), results of a survey etc. The first advantage of spreadsheets is that data can be stored in a structured way, making it easy to retrieve and present data in different ways. Imagine, for example, keeping track of your budget in a notebook, where you might list your expenses like the image to your right.

Storing the same data in a spreadsheet has several advantages over a hand-written record, many of which come from the structure that spreadsheets use to organize data. A spreadsheet is structured like a table, with cells arranged in columns and rows. This overall structure keeps the format of the entries consistent and makes the data more readable.

In addition to the overall structure provided by rows and columns of cells, you can specify the format (eg, bold, italics, etc) and data type (eg, date, text, number, currency etc) of a cell. In the example spreadsheet shown, the cells in the first column are formatted as dates, so they are all displayed with the same month/day/year format.
Similarly, the cells in the third column are formatted as currency amount (in dollars), so they are all displayed with two decimal places and the dollar sign.

Structuring data this way has many advantages. You can use a spreadsheet to sort your data for different arrangements. You can easily create visualizations of your data in the form of bar, line, pie, and other graphs. We will see both of these features in the lab.

The main feature of a spreadsheet, however, is the ability to set up calculations on data that are automatically recomputed when you modify the data. In the example above, you might be interested in total expenses. Later in this lab, you will see how to set up a cell whose value is automatically calculated from the values in other cells. Spreadsheets are often used to store business records and scientific data, because computations like averages, totals, etc are commonly useful with such data.

Part 1: Creating and Editing a Spreadsheet

In this part of the lab, you will create a spreadsheet for keeping a daily record of how many hours you spend doing various things (eg, studying, watching tv, working, sleeping, etc). This is a common time management strategy and can be used in your personal and professional life. Just like when we build websites, it’s helpful to have a plan in mind when you start building a spreadsheet.

1. Decide what data your spreadsheet will store. In this step, you should decide how your data will be stored in rows and columns. In this case, you may choose to store each day’s data in a row. With one row per day, you can then decide what data you’ll record for each day, which will determine what your columns will be. Pick two or three activities you regularly engage in. With each row, you can store the date, and the number of hours you spend that day on each of the activities you have chosen.

2. Start LibreOffice CALC. You can find the program by searching for LibreOffice on Windows’ START page.

3. Most of the CALC window is occupied by your worksheet, the grid of cells where you will record your data. Just like many other applications, there is a menu bar at the top with a toolbar of buttons below. Underneath the toolbar is a CALC-specific bar called the formula bar.

Note that each column can be identified by a letter, and each row by a number. This allows each cell in the grid to be identified by a letter-number combination. We’ll use this later on when building formulas. We will begin by entering our column names into row 1.

4. Enter column names. Editing a cell is as easy as clicking the cell or using arrow keys to move to the cell you wish to edit, then typing the data value that you want in the cell. As shown below, set up column names with the first cells of row 1, using the names of the activities you chose.

5. Format the columns according to data type. Select the date column by clicking the gray A column label. Either by right-clicking and selecting Format cells or by selecting the Format
menu then Cells, you should bring up the Format Cells window, as shown below. Under Category, select Date, and in the Format list, select one that includes the year as well as the month and day. Click OK when you are done and use similar steps to format your other columns using the category selection Number with 0 decimal places, making the assumption that your time recordings will be rounded to the nearest hour.

6. **Enter a row of data.** Begin by entering today’s date in row 2’s date column. Note that because this column is formatted to store dates in a specific way, you can enter a date in a variety of different ways and the spreadsheet will automatically display it in the format you selected. For instance, try entering 7/13 or 7-13-15 etc. Enter hour amounts in the other columns that pertain to their column headings.

 Assuming you intend to record data on a daily basis, you will have to fill in each day’s date in the date column. Typing these in by hand is not only tedious, but error-prone so we will use the fill feature to automatically enter a series of dates.

7. **Select a number of cells in the date column, starting from the cell containing the date you just entered.** To select a group of cells, use the mouse, click in the first cell and then drag your mouse over the cells you would like to include in your selection. You can select any rectangular region of cells this way.

8. **Fill in the selected region.** From the Edit menu, select Fill then Series. Make sure that the Direction is Down, Series Type is Date, Time Unit is Day and Increment is 1.
9. Enter timing data for four more days.

10. Delete the date values for the remaining rows. Do this by selecting the cells you wish to clear and pressing Delete.

Part 2: Formulas for Automatic Calculations on Your Data

Still working on the spreadsheet from part 1, it might be useful to calculate values like the total hours and the average hours spent daily on each activity. These values are different from the data in that they are not values you enter directly, but are calculated from the data that has been previously entered. Using a formula, you can set up a spreadsheet cell to display the results of such a calculation. A spreadsheet formula is just like a mathematical function in that it is used to compute a value based on the values of one or more variables (cells). In the case of a spreadsheet formula, you can set up a cell to perform some computation (like find the sum or average) on the values in other cells. The advantage of a spreadsheet formula is that this cell’s value is automatically updated whenever the data in the other cells are changed.

1. Set up labels for the TOTAL and DAILY AVERAGE number of hours spent on each activity in the date column.

2. Select the cell which will store the total time for your first activity. This would be B7 in the example.

3. Enter the SUM function. To indicate a formula, first type = followed by the function you’d like to use. IE to add a series of values together use: =SUM( ) Inside the parenthesis we’ll need to put a range of cells, specifically the range of cells we’d like to sum or add together. In the example provided, these would be the cells B2, B3, B4, B5, and B6. We can indicate the range of cells by either highlighting them as we type in the formula, or we can type B2:B6 (the range of cells beginning at B2 and ending at B6). In the end our function should be =SUM(B2:B6)

4. Test the automatic re-calculation of the formula cell. Change one of the entries for the activity for which you just created the total cell. The total hours cell should automatically update as soon as you enter a new value. If not, clear the contents of the total time cell and try step 3 again.
5. **Set up a total time cell for your second activity by copying and pasting the formula.** Instead of re-typing the formula, you can copy the formula you completed in step 3. Select the first activity’s total time cell and copy it using **Edit** then **Copy** or by pressing CTRL-C. Select the cell where you want to put the second activity’s total time and paste the function using **Edit** then **Paste** or by pressing CTRL-V. Since we’re using a relative reference the range of values in the sum is automatically updated to reflect the new column.

6. **Set up an average daily time cell for your first activity.** Select the cell where you want the average time for your first activity to be displayed. We’ll want to use a function that will average values for us. To find it, we can use the **Insert** menu, then **Function**. Then we can select the **Category** named **Statistical** and the function named **AVERAGE**. Double-clicking **AVERAGE** will enter the function into the cell. Click OK.

![Function Wizard](image)

7. **Select the range of cells the average should be calculated over.** In the formula bar, you can type in the range of cells that hold the data you’d like to average.

![AVERAGE](image)

8. **Reformat the average time cell to show two decimal places.** This is done using the **Format Cells** window, which we used earlier.

9. **Create a properly formatted average time cell for your second activity.** The formula and formatting can be copied and pasted from the cell we just finished in the step above.

**Part 3: Charts for Visualizing Data**

Visualizing data in charts can often make the data easier to interpret. In this part you will use the **Chart** wizard to create a chart displaying the data in the spreadsheet.
1. Select the data you wish to include in your chart. This should include the dates, hours spent on activities and the headings for the data.

2. Select the Chart Wizard. The icon looks like 📊 or you can navigate to the wizard using the Insert menu, then selecting Object, then Chart. Select the type of chart that best describes your data or appeals to your tastes. Click Next when finished.

3. Verify the data ranges. If you need to change the data range, you can do so on this menu. If you’ve selected all of the data in your worksheet as per the instructions in step 1, then you shouldn’t need to change anything. Click Next when finished.

4. Enter in labels for your chart. Fill in the Title, X axis and Y axis fields to give appropriate labels to your graph. Click Finish when finished.

5. Moving the chart. Click and drag the chart to move it around the spreadsheet. You can also re-size the chart by dragging the corners.

Part 4: Sorting Data

The way you entered your timing data the rows are ordered by date. You might, however, be interested in seeing which days you spent the most time on a certain activity. IE, the rows can be sorted by any column, not just the date column.

1. Start by selecting the data you would like to sort.

2. Sort the data under one activity Select Data then Sort at the top. Try sorting just the current selection. What happened to the data? Next try extending the selection. Sometimes when using the extended selection feature is helpful to enter a blank row or column between the data you don’t want to be sorted. Enter a blank row between total and the last day of data and sort again.

When finished save your spreadsheet as Schedule.ods and turn it in on Canvas.